TI-Nspire Teacher Edition Software for Classroom Instruction

Richard Parr
rparr@rice.edu

Rice University School Mathematics Project
http://rusmp.rice.edu
TI-Nspire™ Technology

*Version 2.0*

Release Notes
Intro

Thank you for updating your TI-Nspire products to Version 2.0. This current version has updates for all of the following products:

- **TI-Nspire™ CAS handheld Operating System Version 2.0**
- **TI-Nspire™ CAS Teacher Software Version 2.0**
- **TI-Nspire™ CAS Student Software Version 2.0**

These Release Notes are to help users that have been using TI-Nspire products update their TI-Nspire Handhelds and/or Computer Software to Version 2.0. These notes will help users see what changes have been made in this most recent release, Version 2.0. Please make sure to update all of your TI-Nspire products to the latest version to take full advantage of new features and enhancements.

Overview

- **Keypad & Software Refresh**

  There is now a new Home Screen that gives a user more options based on what they are trying to accomplish:
  - Quick Calculation and graphing via ScratchPad for mathematics you may not want to save or need to get to quickly
  - Document Management
  - Adding applications to a document

  The TI-Nspire Software got a refresh in Version 2.0:
  - a new look and feel
  - colors in the applications to add clarity and pedagogical value
  - catchy and colorful icons
  - easier access to features you need to use via panels and tabs
  - movable panels make the TI-Nspire Teacher Edition more flexible to use in combination with an interactive whiteboard
  - printing improvements (NB! Soon there will be a patch for the Print All facility!)
  - multiple documents open in one user interface
- **New functionality**
  - Polynomial Root Finder and Simultaneous Equation Solver are added to TI-Nspire CAS. This type of functionality is now built-in to TI-Nspire technology, accessible through wizards or directly by entering commands.
  - Zoom Decimal to trace automatically with step size 0.1.
  - Multiple box plots can be plotted in one Data & Statistics application based on data in different lists and/or columns in Lists & Spreadsheets.
  - The shading under the distribution graph is now available as an option in the wizard of normCdf, tCdf under the utilities panel (when used in the Lists and Spreadsheet app.)
  - For curricula which need algorithmic programming input, dialog boxes are available for programs.
  - Phase plot mode for (recursive) sequences has been added.

The sequence graphing is dynamic which means that you can easily explore the influence of changes of the initial condition(s) by moving around the initial term/point.

Math Expression Boxes became dynamic in a Notes Application resulting in a dynamic algebraic representation that links interactively with the other applications (Calculator, graphs & geometry, lists & spreadsheet) within the same problem.

- **Improvements to the interchangeability of documents between handheld and computer.**

A built-in explorer for computer and handheld in the TI-Nspire software – for the student software as well as for the Teacher software - makes document transfer very easy to do. The handheld, once connected to the computer can be seen as a peripheral and documents can be opened in the software, reworked and saved on the handheld and/or documents created with the software can be transferred very easily to the handheld. It’s just a matter of drag and drop.
Contents

1 Handheld Improvements ................................................................. 5
  1.1 New Keypad Options ................................................................. 5
  1.2 Home Screen ........................................................................ 7
  1.3 Scratchpad ............................................................................. 8
  1.4 Clickable Areas ...................................................................... 9
  1.5 Page Layout ......................................................................... 10
2 Software Enhancements ................................................................. 11
  2.1 Colors & Icons ........................................................................ 12
  2.2 Panels .................................................................................... 14
  2.3 Lesson Bundles ....................................................................... 19
  2.4 Multiple Docs on Desktop ....................................................... 20
  2.5 Printing ................................................................................ 21
3 Computer Software General Updates ........................................... 23
  3.1 Display Continuity .................................................................. 23
  3.2 Document Authoring Enhancements ......................................... 24
4 Mathematical Enhancements Part 1 ................................................. 25
  4.1 Dynamic Sequence Graphing & Phase Plots ......................... 25
  4.2 Zoom Decimal ......................................................................... 27
  4.3 Multiple Box Plots from Lists ................................................... 28
  4.4 Other Statistical Enhancements for Ease of Use ....................... 29
  4.5 Polynomial Root Finder .............................................................. 30
  4.6 Simultaneous Linear Equation Solver ....................................... 31
5 Mathematical Enhancements Part 2 ................................................. 32
  5.1 Interactive Math Boxes. ............................................................ 32
  5.2 User Input and Text Dialog Boxes ........................................... 33
Appendix – Points of interest ............................................................. 34
1 Handheld Improvements

1.1 New Keypad Options

TI-Nspire Clickpad Keypad

TI-Nspire Touchpad Keypad

The buttons of the TI-Nspire Touchpad are organized in three zones:

(i) The Navigation keys

The ScratchPad key, ☐ - see details in section 1.3 – is new and the document (doc) key gives easier access to document management. The doc key activates the document management menu, similar to the previous Tools menu.

(ii) The Math & Numeric keys

The numeric keys are surrounded with buttons for which you have different functionality pressing left and right – except for the enter key. Note that there is no separate key anymore for the “such that” or “with” operator – “|”.

The trigonometry functionality is brought together under one trig key which activates the following palette.

<table>
<thead>
<tr>
<th>sin</th>
<th>cos</th>
<th>tan</th>
<th>csc</th>
<th>sec</th>
<th>cot</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin⁻¹</td>
<td>cos⁻¹</td>
<td>tan⁻¹</td>
<td>csc⁻¹</td>
<td>sec⁻¹</td>
<td>cot⁻¹</td>
</tr>
</tbody>
</table>

For the mathematical symbols press Ctrl [=] :

| > | < | ≠ |
|≥ | ≤ | |
(iii) The Alpha keys

The Alpha keys are brought together as an alphabetic keyboard at the bottom of the handheld with special character symbol keys at the left and at the right.

The navigation is very similar. A comparison:

<table>
<thead>
<tr>
<th>Touchpad</th>
<th>Clickpad</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>esc</td>
<td>esc</td>
<td>Escape</td>
</tr>
<tr>
<td>home/on</td>
<td>home</td>
<td>Home screen (if handheld is on)</td>
</tr>
<tr>
<td>home/on</td>
<td>on</td>
<td>On (if handheld is off)</td>
</tr>
<tr>
<td>ctrl+esc</td>
<td>ctrl+esc</td>
<td>Undo</td>
</tr>
<tr>
<td>ctrl+home/on</td>
<td>ctrl+on</td>
<td>Off</td>
</tr>
<tr>
<td>Ctrl+doc or ctrl+i</td>
<td>ctrl+i</td>
<td>Add page to document</td>
</tr>
<tr>
<td>doc</td>
<td>ctrl+home</td>
<td>Bring up Document menu</td>
</tr>
<tr>
<td>Menu</td>
<td>Menu</td>
<td>Bring up App specific menu</td>
</tr>
<tr>
<td>ctrl+menu</td>
<td>ctrl+menu</td>
<td>Bring up Context menu</td>
</tr>
<tr>
<td>Tab</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>ctrl+tab</td>
<td>ctrl+tab</td>
<td>Switch between apps on page</td>
</tr>
<tr>
<td>scratchpad or ctrl+0</td>
<td>ctrl+0 (zero)</td>
<td>Bring up ScratchPad</td>
</tr>
<tr>
<td>ctrl+trig</td>
<td>ctrl+?</td>
<td>Hints</td>
</tr>
</tbody>
</table>

To type π, ø or á you just type a, o or a and then cycle through the international characters pressing □.
1.2 Home Screen

- Center starting point
- Document management on right & Scratchpad on left
- Direct access to Geometry View

The Home Screen Refresh will help:

- To focus more on the documents and make the use of documents much easier via the right part of the home screen.
- To make calculations and to draw graphs without being in a document via Scratchpad.
- Make it the common starting point - each time you turn on your device you get the Home Screen.

New for document management from the Home Screen is:

- Recent 
  As with computer software, with Recent you can (re)open easily and quickly recently used documents without first going to My Documents.

- Current
  This option takes you to the currently open document – the last opened or created document.

1.3 Scratchpad

Scratchpad allows users to do a calculation or a graph without opening a document. The results of Scratchpad can be saved into a document or added to the current document. Note that Scratchpad is only available for the handheld or in handheld view in the software.

In Scratch Calculate you can use all functionality that’s available for the Calculator except Programming. Programs and User Defined function can be executed in Scratch Calculate. Scratch Graph allows you to use all graphing functionality, but no Geometry functionality.

When you want to save the results of Scratch Calculate and/or Scratch Graph click on Scratchpad and select “Save to Document.” You can select which part to save into a document – Calculate and/or Graph – and if you want to save it in a new document or in the currently open document in to a new problem.
1.4 Clickable Areas

With the new TI-Nspire Touchpad keypad, the handheld’s cursor is now available everywhere:

- **Add page to:** New Document to open an application
- **1.3 1.4 1.5** to select an expression
- **1.3 1.4 1.5** to select a cell

With a cursor available everywhere, more clickable areas are available:

- **Page Tabs and Arrows** in Page heading ( |= Page Navigation & |= Document menu)

- **Menus**
  - 1: Add Calculator
  - 2: Add Graphs
  - 3: Add Geometry
  - 4: Add Lists & Spreadsheet
  - 5: Add Data & Statistics
  - 6: Add Notes

- **Pallets**

- **Settings & Close Document**
1.5 Page Layout

When deleting an application on a page with multiple applications, the page layout will change automatically to one without that application. It is possible to group the applications of two consecutive pages.

For example, to remove a statistical plot created by Quick Graph and to return with a Lists & Spreadsheet page, you just have to select the application Data & Statistics (CTRL K) and press Delete ([←] backspace for computers). Deleting an application can also be done with the Delete Application command in the Document menu.

A function table can be added easily while in the Graphs & Geometry APP (CTRL T toggles the table).

Applications on two consecutive pages can be grouped on one page – in the page sorter or from a page itself – using the Group command from the Document menu. This can be done with up to 4 applications.

The Ungroup command (from the Document menu) separates the applications on a page into separate pages.
2 Software Enhancements

Immediately you will notice the addition of color to the TI-Nspire Version 2.0 Software – Student and Teacher - which gives the TI-Nspire experience a different look and feel.

Before going into more details, first consider three general improvements:

• The File menu contains a Recent Documents option (also available on the Home Screen of the handhelds – see section 1 Handheld Improvements)

• There are only two views: Normal View and Handheld View. In the bottom right you can switch, without opening a menu, between both views:

  ![Switch Views](image)

  For Handheld view it’s possible to zoom in and out:

  ![Zoom Options](image)

• Direct access to document settings by clicking on Settings in the bottom of the window.
2.1 Colors & Icons

The structure of the menus and the naming of the menu items remain very similar to previous versions. However, the icons acquired a noticeable and colorful refresh.

Below are a few menus of applications to get an idea of the new icons.

The following applications allow the use of color to add clarity and didactical value: Graphs & Geometry, Lists & Spreadsheets and Data & Statistics -- especially the Graphing application.

A color group is added to the toolbar:

Colors in documents created with the software will be automatically converted into grayscale when transferred to the handheld. The color information will be stored in the document so when reopened in the software afterwards, the colors are preserved. Also, a document created using grayscale on a handheld will open using corresponding colors in the software.
Here is a quick overview of what can be done with colors in Graphs & Geometry, Lists & Spreadsheets and Data & Statistics.

**Graphs & Geometry**
Graphs will be automatically colored. The color can be changed afterwards using the Color toolbar or right clicking on the graph and select Color.

For geometrical objects, the Line Color option can be used. In the case of Shapes, the Fill Color option.

Note that
- If you select multiple objects, you can change all selected objects to the same color.
- You cannot change the color (black) of text in Graphs & Geometry (but you can color a label to a point).
- The text of the header of a column in the function table has the same color as the graph of the corresponding function.

**Lists & Spreadsheet**
In Lists & Spreadsheet, a cell can be formatted using:
- Fill Color to change the background color of a cell,
- Text color to change the color of the text in a cell.

**Data & Statistics**
In Data & Statistics a plot will be colored automatically in red and can be changed afterwards by Fill Color.

Categorical splits and/or multiple plots in the same application will be colored differently and the color can be changed afterwards.

Please note that the color (black) of text cannot be changed in Data & Statistics.
2.2 Panels

To have easier access to very often used tools the Version 2.0 interface is equipped with panels in combination with Tabs to open the panels. The following panels are available:

- At the left you have the PageSorter, TI-SmartView (Teacher Software) or Keypad (Student Software), My Files and Utilities.

- And at the right a Help Panel and one with Reference / Links (Teacher Software only).

An overview

**PageSorter**

The PageSorter panel is similar to the one in previous versions. Now in Version 2.0 you can rename a problem from the Page Sorter so documents can be more structured and aligned to textbooks and curriculum by giving a more meaningful name to problems than just Problem 1, Problem 2, ...

**TI-SmartView (Teacher Software) or Keypad (Student Software)**

For the TI-Nspire Teacher Software Version 2.0, the keypad and the handheld emulator are available in the same panel which makes switching between them much easier. For the Student Software only the keypad, navigation area included, is available.
My Files

The panel My Files contains the File Management part of the TI-Nspire Computer Link software. It contains two browsers, one for the handheld – My Handheld – and one for the computer – My Computer. Document transfer is just a matter of “copy and paste” or “drag and drop.” When you connect a handheld to your computer it will be automatically detected and the content will be shown in the My Handheld.

Utilities

The Utilities panel contains the Math Templates palette and the Symbols Palette together with the tabs available in the Catalog in previous versions.
Opening documents can be done via My Files by grabbing and dropping a document into the workspace. This is the same for documents on the computer and documents on the handheld.

Documents open in the software can be saved directly to the handheld with the option Save to Handheld.

My Files can be used to upgrade handhelds as well.

For these panels we have the following modes:
For these panels we have the following modes:

**Closed**

**Toggle Auto Hide**

**Toggle Floating**

The Floating mode, for example, is interesting for Interactive Whiteboard users to position the keypad or handheld emulator wherever they want. In this mode the Symbols or Math Templates palette can be on top all the time when entering expressions.

In the Auto Hide mode, the panels will be hidden and the tabs moved to the left side of the screen. This mode gives you more space for the TI-Nspire document. When you hover over the tabs in this mode the panels will pop up. This is also how the panels at the right (Help and Reference / Links) are implemented in Version 2.0.
Help

The Help panel provides – in the TI-Nspire Teacher Software as well in the Student Software – extended help functionality in the TI-Nspire software itself.

Reference / Links

The Teacher Software provides a panel that lists websites with regional content, a Search Engine for tns activities, and a section where educators can save their favorite links to use in the classroom or to prepare their classes.
2.3 Lesson Bundles

Via My Files → My Computer, you can bundle a group of files related to a certain lesson.

For example, name the lesson bundle Complex Numbers. Then double click on the lesson bundle (or click on the lesson bundle and then click Edit/View All Files) to add files to a bundle. Click on “Add Files to Lesson” and select files, all formats allowed, related to the lesson.

After adding files to the lesson bundle, all formats can be open from My Files – if the appropriate application is installed. A lesson bundle can also be dragged and dropped from My Computer to My Handheld and all the tns documents in the bundle will be transferred to a folder with the same name as the lesson bundle.
A lesson bundle can be packed by right clicking on the bundle and select to Pack Lesson. All the files will be compressed into a bundle which can be stored or easily shared (via email). It will appear automatically as a lesson bundle in My Files.

2.4 Multiple Docs on Desktop

In Version 2.0 you can have multiple documents open in one window of the TI-Nspire Software. With multiple documents open, you are able to use TI-SmartView Emulator as well.

Open documents can be viewed as Tabs or as tiles (via Tile documents in the Window menu).

Also in Tile View, handheld view and normal view can be combined and the documents can be edited or animated. The Tile View is ideal to compare answers/solutions from different students.
2.5 Printing

More printing features are added to Version 2.0.

The following new features are available in Version 2.0:

- More paper size selections
  - Letter 8.5 x 11 in
  - Letter 8.5 x 11 in
  - Legal 8.5 x 14 in
  - A5 210 x 297 mm
  - A4 210 x 297 mm
  - A3 148 x 210 mm

- More pages on a sheet
• Reserve space for comments to add notes/comments after printing

• Margin Settings

<table>
<thead>
<tr>
<th>Margins (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top: 1.0</td>
</tr>
<tr>
<td>Left: 1.0</td>
</tr>
<tr>
<td>Bottom: 1.0</td>
</tr>
<tr>
<td>Right: 1.0</td>
</tr>
</tbody>
</table>

• Hide/Show Problem & Pages Labels

• Group Pages by Problem

• Hide/Show Document Name in Footer
3 Computer Software General Updates

3.1 Display Continuity
The following geometrical construction was made using the software:

This same document will look as follows opening it on a handheld using:

TI-Nspire Version 1.7

TI-Nspire Version 2.0

Note that
• The aspect ratio will be preserved when changing from Normal View to Handheld View or when you change resolution for the software.
• For objects such as Text and Sliders you need to be very careful because the size will not decrease when changing from Normal mode to Handheld mode, which can result in overlapping and the image not being completely in the screen.
• For preserving the aspect ratio for Version 1.X documents, they need to be saved first in the Version 2.0 format and then reopened.
3.2 Document Authoring Enhancements

a. Pin command in Graphs & Geometry

Graphs & Geometry provides an option to pin down objects so you won’t be able to grab and move the objects by accident or to change a construction.

![Not pinned Pin command in Graphs & Geometry](image)

b. Grouping in Graphs in Geometry

In Version 2.0 you can group objects in Graphs & Geometry. As a result, you are able to grab and move a group of objects as one object. In that way, the organization of the page layout cannot be disturbed. (NB! You can also attach textboxes to each other to form text chains!)

![Grouping in Graphs in Geometry](image)

c. Document Properties

The TI-Nspire Teacher Software contains the option to add Document Properties to a TI-Nspire document. The Document Properties are available via the File menu in the toolbar. The Document Properties option allows you to add authoring information to documents and to make it read-only. For Copyright, you have the options Public Domain and Copyright. The tab Protection allows you to make the document read-only. The read-only setting can only be turned off using the TI-Nspire Teacher Software.

![Document Properties](image)

The Read-Only option allows educators to share documents but not allow students/colleagues to save changes in that same document. In this way, the document is kept secure.
4 Mathematical Enhancements Part 1

4.1 Dynamic Sequence Graphing & Phase Plots

(i) Dynamic Sequence Graphing

The initial term will be plotted in green and can be grabbed and moved to investigate the behavior of a sequence in terms of the initial condition/term.

(ii) Phase plot: A fox-rabbit model

Suppose the amount of rabbits is depending on its yearly birth percentage and the amount of foxes that can be caught. And that the amount of foxes depends on the amount of living rabbits and the amount of rabbits killed by the foxes.

Some questions
- What will happen with the amount of rabbits when the amount of foxes increases?
- What is the consequence for the food of the foxes?
- What is the consequence on the amount of foxes?
- What is the consequence for the amount of rabbits?

The following phase plot is based on the model determined by the sequences $u_1$, the amount of rabbits, and $u_2$, the amount of foxes as defined below with initial term 200 for $u_1$ and 50 for $u_2$. 
To plot the phase plot, define a Custom Sequence plot as follows:

Here you can also grab the initial point to see how the population evolves in relation to the initial conditions.
4.2 Zoom Decimal

The ZDecimal option has been added to the zoom options of Version 2.0 for Graphs & Geometry.

Zoom – Decimal allows for a Trace Step of 0.1.
Zoom – Decimal allows an easier exploration when tracing the graph.
4.3 Multiple Box Plots from Lists

You are now able to have more than one box plot on a single page.

Suppose the data below represents the scores of a test from a class of 23 students: 8 male and 15 female. The data is stored in columns A and B named as boy and girl, respectively.

Notice below how we created a box plot with the ‘boy’ data. Then we click on ‘boy’ along the horizontal axis, select “2. Add X Variable” and select ‘girl’ from the list of variables. This can be accomplished for several box plots on the same page.
4.4 Other Statistical Enhancements for Ease of Use

a. Frequency plots from Data & Statistics

To create a Frequency plot in Data & Statistics: click on the menu key and select “Plot Properties” and then “Add X Variable with Frequency” and complete the dialog box (or Right-click to add variable!).

b. Draw value of CDF commands (from the list and spreadsheet application!)

Select e.g. Distributions → Normal Cdf in the Statistics menu and fill the Dialog box in as follows:

Note that:
- The option Shade area is new here to visualize automatically the probability to get a value between 80 and 84 out of a population with a normal distribution having a mean of 82 and standard deviation of 2.
- The numeric result will be entered in a cell A1 in Lists & Spreadsheet.
- You can grab the lower or upper limit in Data & Statistics to explore how the probability changes.
- The option Shade area is also available for the other continuous distributions.
4.5 Polynomial Root Finder


The Polynomial Tools have commands that allow you to find roots of polynomials – both real and complex. The commands can be entered either manually or using simple to use wizards.

The roots of \(x^2 - 5x + 6\) are found below:

\[
polyRoots(x^2 - 5 \cdot x + 6, x) = \{2, 3\}
\]

And the complex roots of \(x^2 + 2\) are:

\[
cPolyRoots(x^2 + 2, x) = \{-1.41421i, 1.41421i\}
\]

Although TI-Nspire CAS contains the zeros() and cZeros() commands, the above Polynomial Tools are also added to TI-Nspire CAS to ensure that documents created with TI-Nspire have the same functionality as TI-Nspire CAS.
4.6 Simultaneous Linear Equation Solver

The Algebra menu also contains the submenu, **Solve System of Linear Equations**.

The command -- `linSolve` -- can be entered manually or via wizards.

![Solve a System of Linear Equations](image)

Although TI-Nspire CAS has the ‘solve’ command, the `linSolve()` command is also added to TI-Nspire CAS to ensure that documents created with TI-Nspire have the same functionality as TI-Nspire CAS.
5 Mathematical Enhancements Part 2
Making the Algebraic Representation & Programming Interactive

5.1 Interactive Math Boxes
You now have the option of entering Math Boxes into the Notes Application. You can define a function in a Math Box in Notes, interact with it mathematically in Notes, and see the results in Notes. If you change what was defined in the Math Box, TI-Nspire will update all other interactive Math Boxes related to this change. And TI-Nspire will update all other applications in which the function was referenced - including Graphs & Geometry and Data & Statistics. This brings new educational value and it completes the picture of dynamic linked multiple representations of mathematical concepts.

\[ f_1(x) = x^2 - 2 \cdot x - 1 \]
\[ \frac{d}{dx} f_1(x) = 2 \cdot x - 2 \quad \text{and} \quad \frac{d^2}{dx^2} f_1(x) = 2 \]
\[ f_2(x) = x^3 + 5 \cdot x - \sqrt{2} \]
\[ \frac{d}{dx} f_2(x) = 3 \cdot x^2 + 5 \quad \text{and} \quad \frac{d^2}{dx^2} f_2(x) = 6 \cdot x \]

A Math Box, in Version 2.0, has the following attributes:

In the Math Box you will have the same constraints as in the Calculator application for calculations and evaluation of expressions.
5.2 User Input and Text Dialog Boxes

- With the “Text” command you can provide the user with information about your program:

  \[
  \text{Text: "This is a program that converts temperature"}
  \]

- With the “Request” command you can enter values to be used in the program:

  \[
  \text{Disp "Convert:"} \\
  \text{Disp "1 - °F to °C} \\
  \text{Disp "2 - °C to °F"} \\
  \text{Request "Choose an option:", \textit{opt}} \\
  \text{Request "Enter Temperature in °F:", \textit{tf}}
  \]

- The “RequestStr” command works similar as Request, except the input needs to be a string.

When combined with programming loops, the Request and RequestStr commands can also be used to let the user make decisions.

  \[
  \text{RequestStr "Do you want to do another conversion? Yes/No", \textit{counter}}
  \]
Appendix – Points of interest

You are now able to detect points of interest in graphs – zeros, maximums, minimums, ... using the Analyze Graph feature as illustrated below. Notice that the graphical tools for the derivative and integral are now included in this menu (but to enter numbers for derivative and integral you must first type “(“ !).

The Analyze Graph tools are also added to the context menu when right clicking on a graph.
6.2 Plotting points by entering its coordinates

When you hover over the icon in the upper left corner of Graphs & Geometry a tooltip will open automatically.

This ToolTip tells you that you can also plot a point by pressing "(" and subsequently entering its coordinates. Pressing "(" opens a template in which you can enter the point's coordinates. Confirm each coordinate by pressing enter!

To avoid screen clutter for the handheld the coordinates won’t be visible after plotting the point. As before right clicking on the point gives quick access to the coordinates of the point.

Objects defined by points (a segment, a triangle, a circle, …) can also be plotted by entering the coordinates of the points, each time pressing "(" to enter the point's coordinates.